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Introduction 
XAP 1.0 is a rugged and compact controller designed as a powerful IIoT gateway and a 

programmable unit for building automation functions. It is empowered by a configurable web 

interface which makes it an outstanding HMI without screen. It integrates the standard IEC 61131 

PLC (Codesys), so that any building automation function can be programmed by means of a 

standard and well-known tool. The powerful software Wizard Studio permits an easy setup of 

graphic pages, functions and protocols. 

 

Assumptions 

We assume that readers have a basic understanding of computers, Microsoft Windows, and the 

specific network environment where the application will run. 

This manual is intended for users or technicians directly involved in the installation of XAP device 

and its integration to UWP 3.0 systems. 

 

Note: This manual is not intended as CODESYS V3 programming manual, for 

detailed documentation regarding CODESYS V3 Development System please 

refer to the CODESYS web site www.codesys.com and to its on-line help. 

 

Note: For detailed information regarding the use of Wizard Studio software and 

related to the communication with HMI Runtime please refer to the Wizard Studio 

manual available on productselection.net. 

 

General description 

This manual describes 

CODESYS V3: 

⚫ How to configure a CODESYS V3 environment and Wizard Studio integration 

⚫ How to program internal CODESYS V3 PLC available in XAP device 

⚫ How to create a project to get communication with XAP device 
 
OPC-UA:  
 

The OPC UA Client communication driver is designed to connect XAP devices to OPC 
UA servers. This implementation of the protocol operates as a client only in order to 
public tags that are already defined in a Wizard project. 

 

Node-RED:  
 

Node-RED is a programming tool for wiring together hardware devices, APIs and online 
services. 

  

http://www.codesys.com/
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Requirements and Limitations 

The following firmware and software versions are required to work with the CODESYS V3 PLC 

Runtime: 

Element Version 

Wizard Studio suite 2.8.0 build 441 or higher 

HMI Runtime application 

Note: HMI is an application installed on the XAP device 

by using Wizard Studio 

2.8.0.441 or higher 

CODESYS V3 Development System V3.5 SP15 - 32 bit version ONLY 

 

Note: The XAP HMI Runtime is compatible with CODESYS V3.5 Development 

System only. CODESYS V2.3 Development System is NOT compatible with 

CODESYS V3 Runtime. 

 

If a newer version of CODESYS V3 Development System is already installed, make sure to 

use 3.5.15.0 versions of libraries to program XAP device HMIs. 

 

System requirments 

Element Details 

Supported Platforms/ Devices 

Windows 7 (Service Pack 1 or higher) / 8 / 10 

(32/64 Bit), suitable PC hardware for the 

corresponding Windows platform 

Additional Requirements Microsoft Internet Explorer 11, or higher 

Licensing - 

Required Accessories - 
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Architecture 

HMI and PLC based on Internal PLC (CODESYS) and CODESYS V3 can be applied in different 

configurations. The picture below shows how HMI and PLC can be configured. 

 

 

 

Note: Refer to table above to know which optional plugins and fieldbusses are 

available for your hardware configuration 
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Default parameters 
The device is set in the factory with the following parameters. 

 To access the XAP device for the first time, use these parameters. 

PARAMETER DEFAULT VALUE 

ETH0 / WAN Set as DHCP client 

ETH1/LAN 

IP Address: 192.168.0.1  

Subnet mask: 255.255.255.0 

System settings page https://192.168.0.1/machine_config 

Username admin 

Password Gav@zzi!2015 

 Note: The username and password are case-sensitive. 

 

WARNING: For security reasons, change the default passwords for both usernames 

(passwords can be modified from the System Settings > Authentication command) 

 

 

See the procedures in this manual. 

 

  

https://192.168.0.1/machine_config
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Getting Started with CODESYS 
This chapter provides the necessary information on how to set-up the XAP device and CODESYS 

V3 PLC system. 

The required operations are listed below and explained in the forthcoming chapters. 

▪ CODESYS V3 Development System installation 

▪ Additional CODESYS packages installation 

▪ HMI Runtime installation on XAP device 

▪ Activation of the CODESYS V3 license on the HMI 

▪ Creation of a new PLC project 

▪ Download/upload PLC application 

▪ Communication Setup in Wizard Studio 

▪ Symbol File configuration with CODESYS V3 Development System 

 

Procedures 

Create a CODESYS account 

Access to https://store.codesys.com/customer/account/ select a type of account and click to 

Create an Account to proceed. 

 

Follow the indication on screen to finish the registration procedure. 

  

https://store.codesys.com/customer/account/


 

XAP1.0 – Configuration manual 10 

 

CODESYS V3 Development System installation 

The CODESYS V3 Development System suite can be downloaded for free from the Codesys 

website after registration. Follow this procedure to download and install the software on your 

computer. 

Step Action 

1 Click to https://store.codesys.com/ to access the CODESYS Store. 

2 

Select CODESYS Development System V3 and click to DOWNLOAD 32 BIT 
option. 

 

 Be sure to download the 32bit version, the other versions are not supported. 

3 
In the popup that appears, click on Accept button to confirm the Licence agreement 
to start the software download. 

4 
Perform the Setup_CODESYSV.exe to start the installation assistant which will 
guide you.  

5 

Click Next > button to continue. 

 

https://store.codesys.com/
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6 

Select I accept the terms in the license agreement and click Next button to continue 

 

7 

Select I have read the information option and click Next to continue. 

 

8 

Select the Destination folder and click Next button to continue. 
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9 

Select Complete option and press to Next. 

 

10 

Click to Install to start the installation procedure. 

 

Note: The installation procedure takes several times due to your Computer 
performance. 

11 

Click Finish button to end the installation procedure. 
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Package Manager 

Things to know 

CODESYS Development System includes a tool called Package Manager for the installation of 

the CODESYS Package. Package Manager tool can be launched from CODESYS Tools menu, 

selecting the proper menu item. This tool can be used both for checking the installed Packages 

and for installing new ones. 

There are two dedicated CODESYS packages that are required to allow the standard CODESYS 

V3 programming software to program XAP device HMI Runtime. These packages are provided 

with the Wizard Studio installation suite.  

Procedures 

Additional CODESYS packages installation 

This document explains where to find and how to install the CODESYS packages, containing the 

needed information regarding the XAP device to be programmed. These are required to allow the 

standard CODESYS v3 workbench to programme Codesys based PLCs. 

Step Action 

1 
Start CODESYS  application. 

2 

From Tools menu, select Package manager option, in the window that appears, 
click on Install button: 

 

3 
Browse the folder 
 

C:\Program Files (x86)\CG\Wizard Suite2.8.0.441\CODESYS\V3 

4 
Select the first package called CODESYS_JMobile_3.5.10.50_8.package and click 
Open to install the package. 
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5 

Select Complete setup option and click Next button. 

 

6 

 

 
 

7 
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8 
Select the second package POWERLINK for CODESYS_4.0.0.20.package and 
click Open to install it. 

 

Check the box to accept the License agreement under the window.

 

9 

Select Complete setup option and click to Next to continue. 

 
 

10 

Check the CODESYS V3.5 SP15 option before continuing and click Next. 

 
 



 

XAP1.0 – Configuration manual 16 

 

11 

Click Next to start the installation procedure. 
 

 
 

12 

Click to Finish to end the installation. 
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Updating old CODESYS Packages 

When a new version of Package is released XAP device always tries to guarantee the 

complete compatibility with the previous versions. 

When a new version of the CODESYS Package is available, it can be installed to 

update the Package information accordingly to the latest CODESYS V3 PLC Runtime 

features. 

If the new Package is not fully compatible with the previous version some changes to adapt the 

PLC application to the new Package may be required. 

The Package update procedure is identical to the first installation of the CODESYS Package, 

please refer to the proper chapter for specific information. 
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XAP HMI Runtime installation with CODESYS license 

Thing to know 

Activate Codesys license on XAP device 

As the CODESYS PLC Runtime is part of the HMI Runtime it is necessary to install the HMI 

Runtime on the HMI to have the PLC Runtime running. 

Step Action 

1 
In Wizard Studio select Run > Manage Target. 

2 From Target field select the XAP device among those available  

3 Click on Update runtime button to proceed. 

4 

Once the HMI runtime is installed into the XAP device it is automatically 

rebooted. 

Note: It takes up to three minutes to complete the upgrading process. 

 

For further information on installing the HMI Runtime, please refer to Wizard Studio 

Manual. 
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Creation of a new PLC project 

 

When you start the programming system the first time after first installation on the system, you 

will be asked to choose the default collection of settings and features: 

Step Action 

1 Select File > New Project or click on the  icon from the upper tools bar. 

2 
Select Standard Project in the Templates section. 

Note: In the "Standard" environment the user interface is adapted for most effective 
usability and some rarely used features are left out. 

3 

Select Standard project in the Templates field and enter a Name and a Location 
path for the project file. Press OK to confirm. 

 

4 

In the wizard dialog, choose device 600L/700 (Linux) and the programming 
language for PLC_PRG project. 

 

5 Press OK to open the new project. 
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Download PLC application 

The selection of the PLC where to download the project must be done from Device communication 

settings tab before proceeding with the download operation. 

Step Action 

1 

Double click on Device (<device_name>) in the project tree to display the Device 

properties in the work area. Insert the IP address of the XAP device and press Enter key. 

 

2 

A green dot over the device graphical representation informs that the device is correctly 

recognized and available into the network. 

 

Note: Communication with the available devices is established through a Gateway, a 

default Gateway is available, and it is generally not needed to change the standard 

Gateway settings. For more information about the Gateway set-up please refer to 

CODESYS V3 documentation. 

3 
If PLC IP Address is unknown, select the Communication Settings tab then click on 
the Scan Network… button. 

4 

The Select Device dialog will be displayed. This dialog lists all the compatible devices 

available in the network. Select from the list the XAP device to be programmed then 

press on OK. 

5 

In case several XAP devices using CODESYS V3 PLC Runtime are present into the 

network, each XAP device is recognized by a different string between square brackets 

reported after Device name field. 
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Example 

In the next figure the string is “0000.29D8”, the last part of the string “29D8” corresponds to the last 2 

bytes of the XAP IP Address in Hex format so, in this case, the corresponding XAP device is the 

one with IP address xxx.xxx.41.216 as 29Hex corresponds to 41Dec and D8 Hex corresponds to 

216 Dec. 
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Upload PLC Application 

The upload of the PLC project is possible only if the project Source has been previously 

downloaded into the PLC. To download the project source, while Online, select the Online > 

Source download to connected device command. 

To upload a PLC project from the XAP device, select the Source upload command from the File 

menu, as shown in the following figure, then select the XAP device from Select Device window. 
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Exporting SYMBOL File configuration from 

CODESYS 
The Symbol file is designed to easily share variables between CODESYS V3 and Wizard Studio 

projects for XAP devices. The Symbol file created in CODESYSYS V3 can be imported into 

Wizard Studio projects in order to make all the Codesys variables available for use. 

Procedures 

When creating the project using CODESYS V3, properly configure the symbol file to contain the 

required variables. To add the Symbol configuration in CODESYS V3 project, follow the 

procedure below: 

STEP ACTION 

1 

Right click on the Application item from the project tree, then into the context menu select 
Add Object > Symbol configuration. The symbol configuration item will be added to the 
project tree. 

 

2 

Double click on Symbol configuration item, then click on Build button. 
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3 

Symbol configuration item contains a list of all the variables available into the CODESYS 
V3 project, single variables or groups of variables can be selected by checking the 
corresponding item in the list. 

 

4 
After the symbols have been configured, download the project or use the Generate 
code function (Build > Generate code) to create an .xml file containing all the variables 
read to be imported in the Tag Editor. 

 

Note: GVL global variables are listed in Symbols Configuration only if they are used in PLC program.  

 
To always list global variables right click on GVL and select Properties. From Build tab check 
Link Always option. 
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Communication Setup in Wizard Studio 

XAP Runtime communicates with the internal CODESYS V3 Runtime using the CODESYS V3 

ETH protocol. Localhost 127.0.0.1 should be entered in IP Address parameter; this identifies the 

PLC as internal CODESYS V3 Runtime. 

 

Additional information regarding CODESYS V3 ETH driver are available in Wizard Studio Help > 

Communication Drivers section. 
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Importing Symbol Files in Tag Editor 

Wizard Studio Tag Editor requires direct import of CODESYS V3 symbol file for the definition of the 

Tags. 

To import the .xml file containing Symbols, follow the procedure below: 

STEP ACTION 

1 

In the Wizard Studio, select the CODESYS V3 ETH protocol in Tag Editor and click on 
the Import Tags button to start the importer. 

 

2 

The following dialog shows which importer type can be selected. 

 

The available options are as follows: 

Importer Description 

CODESYS3 xml v1.0 Linear Requires an .xml file. 
All variables will be displayed at the same level. 

CODESYS3 xml v1.0 Hierarchical 
Requires an .xml file. 
All variables will be displayed according to 
CODESYS V3 Hierarchical view. 

Tag Editor exported xml 

Select this importer to read a generic XML file 
exported from Tag Editor by appropriate button. 

  

3 Once the importer has been selected, locate the symbol file and click Open. 
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4 

Tags included in the symbol file are listed in the tag dictionary. The tag 
dictionary is displayed at the bottom of the screen. 

 
 

 

Things to know 

Memory Layout 

The table below shows detailed information about maximum allowed size of CODESYS V3 

project. 

Memory Type Maximum Size 

Data, Input, Output, Memory and Code 20 MB 

Retain 16 KB 

Persistent 16 KB 
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Things to know 

The following table describes the behaviour of the toolbar items: 

Toolbar item Description 

 

Import Tag(s) 

Select tags to be imported and click on this icon to add tags from tag dictionary to 
the project. 

 

Update Tag(s) 

 
Click on this icon to update the tags in the project, due a new dictionary import. 

 

Recursive 

Check this box to import all sub-elements of a tag. 

Example of both checked and unchecked result: 

 

 Searches tags in the dictionary basing on filter combo-box item selected. 
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Getting start with OPC-UA 

Things to know 

The OPC UA Client communication driver has been designed to connect XAP devices to OPC 
UA servers. The service can be used to public Tags to OPC UA servers. 

Note: the implementation of the protocol operates as a client only. 

 

Procedures 

Enable OPC-UA 

OPCUA service has to be enabled in the Wizard Studio project you are developing. Follow the procedure 
shown below: 

Step Action 

1 From the Project view click the [+] to expand Interfaces tab. 

2 

Right-click on the OPC UA option and click to Enable button. 
 

 

3 Double-click on the OPC UA option to access the settings page. 

4 

In the Tag groups field, you can select the groups you want to public to 
OPC UA server; selecting All, all the available tags/groups 

 

5 
In the Network section > Node name field enter an identification name 
that help to recognize the XAP device in case several XAP devices are 
available in the network. 

6 Download the Wizard Studio project into the XAP device. 
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Test OPC-UA client 

OPCUA service has to be enabled in the Wizard Studio project you are developing. Follow the procedure 
shown below: 

Step Action 

1 Execute UA Expert client  

2 Select Add.. from Server tab 

3 In the Add server window, click Advanced tab 

4 

In the Endpoint Url field insert the OPC-UA server reference with the 
following syntax: 

opc.tcp://<XAP IP Address>:48010  

 

5 Enter an identification name in the Configuration name field 

6 

In the Project view, right click on the server item and click to Connect 
button 

 



 

XAP1.0 – Configuration manual 31 

 

7 

The first time, in the Certificate Validation window, click on Trust Server 
Certificate to accept it click on Continue button. 

 

8 

In the Address space are shown all the available Tags 

 

9 

By Drag & drop action add the tags to the Data Access View panel  
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Getting start with Node-RED 
 

Things to know 
To install node-RED into a XAP device, you need 

• an empty USB Stick  

 

• the Node-RED_package.zip available on productselection.net 

 

Procedures 

Install Node-RED on XAP device 
Follow this procedure to install Node-RED on XAP device. 

Note: Autorun scripts from external storage option in XAP machine_config -> System settings -> 

Services must be enabled. 

Step Action 

1 
Extract the content of the folder “Node-RED_installer” into the root folder of a USB 
stick. 

2 

Plug the USB stick into the XAP device: it buzzes one time to indicate the process 
is started. 
 
Note: If XAP device does not emit any sound this means the USB is not working or 
the content is not present. 

3 
The installation procedure usually takes up to three minutes. 
Once the procedure successfully finishes, the XAP device buzzes three times.  

4 
Remove the USB sick to automatically reboot the XAP device. 
 
Note: Please wait two minutes to get the device up and running 

5 

After installation, in order to configure node-RED you need to open web browser 
and digit the following url: 
 
http://<XAP IP address>:1880 
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User interface 

At the first time, the Node-RED interface appears as shown in the picture below: 

 

Procedures 
To do a communication test with Node-RED and tags that are running on XAP device, you can 

use a free MQTT solution. Follow the procedures below. 

Create a CloudMQTT account 
Access to https://customer.cloudmqtt.com/signup and provide your information to create a new 

Free account. 

 

Follow the indication on screen to finish the registration procedure. 

  

https://customer.cloudmqtt.com/signup
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Create a new Instance 

Step Action 

1 Access to CloudMQTT account. 

2 Click to  button in the top right corner. 

3 

a) Enter an indentification name in Name field. 
b) Select Cute Cat (Free) value form brop-down menu. 

Note: see https://www.cloudmqtt.com/plans.html for details about available plans 

c) Enter option tags value in Tags field. 

 

Click Select Region button to continue. 

4 

Select the preferred Data center form the drop-down menu. 

 

Click on Review button to continue. 

5 In the next page, check that all the information provided are valid then click on 
Create instance to finish the procedure. 

 

 

  

https://www.cloudmqtt.com/plans.html
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Import the Node-RED example project 
The file Generic_MQTT_example.txt  is a Node-RED flow available in the “Node-RED 

package.zip” folder. Follow this procedure to import and set the example within your references: 

  In the Wizard Studio project, the Security option (ProjectView > Security) must be 

disabled.  

You must change all the tags reference and the MQTT server settings in the example file. 

Step Action 

1 Open the Node-RED interface in a web browser. 

2 

Drag&Drop the Generic_MQTT_example.txt file onto Flow area. 

 

3 

The Node-RED flow related to the imported file is shown: 
 

 
 

Debug node 

Read Tag  

from Wizard 

Studio 

CloudMQTT server  
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4 

Double click on the Read Tag node to enter the settings page: 
Set in the Id field the same Tag name that is shown in Wizard Studio in Tags tab. 
In the Name field you can enter a description to identify the variable. 

 
 
Click on Done button to store the changes.  

5 

Double click on the CloudMQTT server node to enter the settings page. 
This node must be set with the CloudMQTT server information. To get these 
information access to the CloudMQTT and access to the Instance settings page: 
 
In the Server field enter the value present in the Server field. 
In the Port field enter the value present in the Port field. 
 

  

6 

Click the Connection tab to enter: 
in the Server field the value present in the Server field. 
in the Port field the value present in the Port field. 
 

  
 
Click on Update/Done button to store the changes. 
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7 

Click to Deploy button to compile the project: 
 

 
 
The status indicator is shown below the CloudMQTT server node 
 

 
 

8 
Click to Debug tag to see the updated value that are sent to MQTT broker 
(CloudMQTT) in real-time. 

 

Example 

In the example shown below the project is running on Node-RED. The UWP3.0 – Humidity and 

UWP3.0 – Temperature tags represent two variables read from Wizard Studio via Modbus TCP 

protocol: their value is sent to CloudMQTT free portal every time their values changes. 

 

 

 

 

 

 

 

  



 

XAP1.0 – Configuration manual 38 

 

Appendix 

System settings 
The user interface of System Settings is based on HTML pages and can be accessed remotely 

using a Web browser. 

Procedures 

System settings access from Web browser 

To access System Settings, follow this procedure: 

STEP ACTION 

1 

From any standard web browser, enter the IP address of the XAP device, in the 
following format: 
 
https://IP Address/machine_config 

2 

Since the certificate is not signed from a Certificate Authority you will get a warning 

message: click on ADVANCED options and choice to proceeding: 

 

 
 

Note: the remote access use encrypted https protocol on port 443. When the 

connection is established, the XAP device sends a certificate to use for the 

encryption.  
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3 

Browse through the options available in the menu on the left: the active item is 

highlighted and related information is displayed in the right: 

 

 

  

Notes:  

To change values, enter in edit mode by clicking the   button on the right top.  
The edit button is available only inside the dialogs that contains modifiable parameters. 
 
 

Change the language 

By default, the language is set to English. 

To change the language, from the left menu, select the language for the interface. 
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System tab 
The System menu collects device information  

Parameter Description 

Info Device information 

Status Device status (Free RAM, Up time, CPU Load) 

Timer Device timers (System on, Back light on)  

Plugin Hardware plugin information 

Logs tab 
From the Logs menu you can set the persistent log option if you want to maintain the log files 

saved after a power reset. 

Use Save button to export a copy of the log files. 

Note: the log files manager cyclically fill 3 files of 4 MB 

Date & Time tab 
The table below shows the available parameters in order to set Date and time of the device: 

Parameter Description 

Current Time zone Time zone region. 

Current Date Local Time Date and Time can be set manually only when the Automatic Update is 
disabled. 

Automatic Update (NTP) 

Enable to keep date and time synchronized from a remote server: 

NTP Server 
Specify the Internet NTP Server address: 

 
The NTP Client of the HMI Device is a complete implementation of the 
Network Time Protocol (NTP) version 4, but also retains compatibility 
with version 3, as defined by RFC-1305, and version 1 and 2, as defined 
by RFC-1059 and RFC-1119, respectively. 
 

The poll process sends NTP packets at intervals determined by the clock 
discipline algorithm. The process is designed to provide a sufficient 
update rate to maximize accuracy while minimizing network overhead. 
The process is designed to operate in a changeable mode between 8 
sec and 36 hr. 
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Network tab 
Note: Network parameters are available in edit mode: 

Parameter Description 

General Settings Device hostname 
Avahi Hostname (see "Avahi Daemon") 

Network Interface 

Network parameters of the available interfaces: 

⚫ DHCP 
⚫ IP Address 
⚫ Net Mask 
⚫ Gateway 

DNS 

DNS Servers 
Generally provided from the DHCP servers, but can be modified in edit 
mode 
 

Search Domains 

Optional domains that will be used in concatenation with the provided urls 
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Services 
Note: Services are available only when logged as admin. 

 

Mouse click on the enable button to enable/disable the service. Click the service name 
to list the associate parameters. 

 

Avahi Daemon  

Avahi is a system which enables programs to publish and discover services and hosts 
running on a local network. When it is enabled, the XAP device can be reached even using 
the device's host name (in alternative to the IP Address). 

Avahi Daemon runs on UDP port 5353 

 

 

Note: On Linux and Apple PCs, the Avahi service comes for free with the OS. On Windows 
PCs instead, you need to install an Avahi service to be able to reach the panel by his Avahi 
host name (e.g. you need to install the Apple Bonjour application - Bonjour is a trademark of 
Apple inc.). 
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Bridge Service 

Using the bridge service is possible connect together the WAN (ETH0) network adapter with 
the LAN (ETH1) network adapters. When used, the two Ethernet adapters are bridged and 
both Ethernet adapters are sharing the same IP address. 

Bridge Service creates a Linux-based layer-2 Network Bridge between two or more network 
interfaces. If both WAN and endpoint devices are attached to such bridge, the two networks 
will be physically joined and endpoints will be available as if they were directly connected to 
the WAN. 

 

 

Fast Boot 

When fast boot is enabled, at the power up the XAP will start the HMI application as fast as 
possible. In this mode, there are not showed diagnostic information (e.g. the loading bar) but 
only the minimum necessary features are loaded before loading the User Interface (e.g. 
System Settings, VNC, SSH, etc. will be load after loading the HMI application). 

To obtain best performance, in addition of enabling the fast boot mode, it is recommended to: 

 

⚫ disable any service that is not necessary 

⚫ avoid keeping enabled the persistent log 

⚫ use static IP address instead of DHCP service 

 

Router Service 

This service uses the IP Forwarding and the Network Address Translation to share the 
connections from WAN (eth0) towards LAN (eth1): the connected endpoints may reach the 
same networks reachable by the gateway (including Internet if available). 
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SNMP Server 

SNMP is a network protocol that allow to manage network infrastructures. It is commonly 
used to monitor network devices as switches, routers, etc. connected to a LAN network. 

When the SNMP service is enabled, an SNMP Manager can retrieve information from the 
HMI device using the SNMP protocol. Currently, there are not proprietary MIBs available. 
Only the standard public community MIBs are available in read only mode. 

SNMP Server runs on UDP port 161 

 

 

This service is designed to be used during the development phase. For security reasons, 
remember to disable the service before switch to production. 
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SSH Server 

SSH service has been designed only for advanced users. It provides remote login to HMI 
device using the secure shell protocol. On PC you can run a SSH Client as, for example, 
PuTTY that is an open source software distributed under the MIT license. 

SSH Server runs on TCP port 22 

The default password for the username is “admin”. See the "Authentication" chapter to 
additional information. 

 

 

This service is designed to be used during the development phase. For security reasons, 

remember to disable the service before switch to production. 
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Plugins 
 

This page will show the parameters available to configure the optional plugins modules 
attached to the XAP device. See the description of each plug-in module to additional 
information. 

 

Management 
Note: Management is available only when logged as admin. 

From the management area is possible Update System Components of the XAP device. 

 

CAUTION: Working in the Management area is a critical operation and, when not performed 
correctly, may cause product damages requiring service of the product. Contact Carlo 
Gavazzi technical support for assistance. 

 

Restore to factory settings 

Use the Clear command inside the Data section to remove HMI Runtime from the XAP 
device (Factory Restore) 

 

Restart 

XAP device restart command 
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Authentication 

Enter in edit mode to change the authentication passwords. 

Administrator username with full access right is "admin" with default password "admin". 
Generic username is “user” with default password “user”. 

WARNING: For security reasons, change the default passwords for both usernames 

x.509 Certificate 

XAP device use a self-certificate to encrypt the Internet communication trough the HTTPS 
protocol. You can personalize the certificate with the data of your Company and ask to a 
Certificate Authority to firm it. 

 

The procedure to personalize and firm your certificate is: 

Step Action 

1 
Enter in edit mode and fill the necessary parameters, then push GENERATE button to 
generate a self-signed certificate with your data. 

2 Export the “Certificate Signed Request”. 

3 
Sent the “Certificate Signed Request” to a Certificate Authority to firm it (general this is a paid 
service). 

4 Import the signed certificate into the HMI device. 

 

Certificate's parameters 

 

Parameter Description 

Device Name The name of your device 

Organization The legal name of your organization 

Unit The division of your organization handling the certificate 

State The state/region where your organization is located 

Location The city where your organization is located 

Country The two-letter ISO code for the country where your organization is location 

Valid (days) Validity of the certificate 

Key Length Number of bits of the key used from the cryptographic algorithm 

Managed certificates are base64 encoding. 

 

EXIT 

Exit from the System Setting menu.  
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